
ภาคผนวก ก
การไดมาซึ่งขอมูลสารสนเทศภูมิศาสตร

การไดมาของขอมูลสารสนเทศภูมิศาสตร ซึ่งประกอบดวย
ขอมูลชนิดภาพ (Raster) ซึ่งเปนขอมูลจากภาพถายทางอากาศ
ขอมูลชนิดเวกเตอร (Vector) ซึ่งเปนขอมูลลายเสน เชน เสน (PolyLine) พื้นที่รูปปด 
(Polygon) และ จุด (Point)
1. ขอมูลภาพ (Raster) เปนขอมูลภาพถายทางอากาศบริเวณเขต เทศบาลนครเชียงใหม 

ถายเมื่อเดือนพฤศจิกายน พุทธศักราช 2543 นํามาจากภาพถายจุด ผังเมืองจังหวัด
เชียงใหม ขนาดภาพละ 4 ตารางกิโลเมตร ในรูปแบบของไฟลชนิด JPEG แลวมาทํา
การกําหนดคาพิกัดบนภาพถาย (Image Registration) โดยวิธี Rubber Sheet 
Registration โดยใชโปรแกรม AutoCADMap จุดควบคุมภาพใชวิธีการวัดตําแหนง
บนผิวโลกจาก Land Mark ที่เห็นบนภาพ โดยใชเคร่ืองรับสัญญาณดาวเทียมชนิด 
GPS. ระบบพิกัดที่ใชในการควบคุมภาพ เปนระบบพิกัดภูมิศาสตร (Geographic 
Coordinate System) และใชศูนยกําเหนิด (Datum) เปน Indian 1975

รูปที่ 1 ภาพถายทางอากาศเมื่อไดรับการปรับคาพิกัดแลว
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ใน AutoCAD Map ตองกําหนดระบบพิกัดใหสอดคลองระบบพิกัดที่ตองการ ซึ่งสามารถกําหนดได
ดังนี้ ใน AutoCAD Map Menu MAP � Assign Global Coordinate System จะปรากฏดังภาพ

รูปที่ 2 Thailand west of 102d East; Indian 1975 Datum
ใหระบุ Coordinate System และ Datum เปน THAI-W75ใชในการทํางานครั้งนี้

เนื่องดวยภาพถายทางอากาศที่นําเขามาใชในคร้ังนี้มีขนาดไฟลคอนขางใหญมากรวม 700 MB เพื่อ
ทําใหการประมวลภาพถายทางอากาศแตละคร้ังของเซิฟเวอรไมทํางานหนักมากเกินไป กอนสงขอ
มูลที่ไดกลับไปยังผูเรียกใช (Client) จึงจําเปนตองทําภาพที่มีขนาดใหญซอยยอยลงมาเปนแผนๆ
เล็กๆเพื่อความเร็วในการประมวลภาพถายแตละคร้ังของ เซิฟเวอรกอนสงไปยังผูเรียกใช โดยใช
โปรแกรม Image Ready โดยการเปดภาพที่ตองการซอยยอยแลวเรียกใชคําสั่ง Select -> Select All
จากนั้นเรียกใชคําสั่ง Slice -> Slice จากนั้นระบุจํานวนภาพที่จะซอยยอยในแนวตั้งและแนวนอน
เพื่อทําการเชฟออกมาเปนไฟลยอยๆดวยคําสั่ง save Optimized
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รูปที่ 3 ลักษณะภาพถายทางอากาศที่ถูกแบงออกเปนแผนยอยๆ

รูปที่ 4 การแบงภาพเปนแผนยอยๆ จํานวน 10x10 ภาพ
แลวเพื่อลดขนาดของภาพลงเมื่อไดภาพถายทางอากาศที่ไดจากการหั่นเปนแผนยอยๆแลวจากนั้นก็
นํ้าภาพถายทางอากาศดังกลาวเขาสู AutoCAD Map
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การจัดวางตําแหนงพิกัดใหถูกตองโดยใชคําสั่ง Insert � Raster Image เมื่อนําภาพถายทางอากาศ
เขาสู AutoCAD Map ครบแลวก็ทําการ Export World Files ซึ่งเปนไฟลที่ระบุคุณสมบัติของภาพ
ถายแตภาพใหสอดคลองกับพิกัดโลกในการอางอิง

                                      รูปที่ 5 การสงออกขอมูลพิกัดของภาพถายทางอากาศ
2. ขอมูล เวคเตอร (Vector) ไดมาจากสองสวนหลักๆคือ

1.1.1 ระบุในแผนที่ ที่ไดรับปรับแตงพิกัดภาพถายทางอากาศใหตรงกับพิกัด
โลกแลวขอมูลดังกลาว เชน ตําแหนงอาคาร ขอบเขตพื้นที่ของแขวงตางๆ เปนตนขอมูลที่
ไดจากการบันทึกเสนทางโดยใช อุปกรณนํารองดาวเทียม (GPS) ในการจัดทําเสนทางโดย
ตรง โดยมีวิธีการดังนี้นําปาลม เชื่อมตอกับ อุปกรณนํารองดาวเทียม (GPS) โดยใช
โปรแกรม Cetus เพื่อบันทึกเสนทาง (Tracking)

1.1.2      อุปกรณระบุตําแหนงดวยดาวเทียมถือวาเปนหัวใจหลักในการบันทึกเสนทางภาพ
ที่เห็นอุปกรณกําลังหาตําแหนงดาวเทียมเพื่ออางอิงพิกัดที่อยูปจจุบันซึ่งตองใชดาวเทียมต้ัง
แต 3 ดวงขึ้นไปเพื่อระบุตําแหนงตัวเองได ชวงเวลาที่ตําแหนงดาวเทียมเหมาะสมจะเปน
ชวงที่รับสัญญานดาวเทียมไดดีที่สุดซึ่งจะใหคาผิดพลาดนอย จึงมีความแมนยําสูงในการ
บันทึกเสนทางตางๆ (ภาพ GPS กําลังหาสัญญาณดาวเทียม)
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รูปที่ 6  อุปกรณระบุตําแหนงดวยดาวเทียมและปาลม

อีกสวนหนึ่งที่มีความสําคัญอุปกรณบันทึกขอมูลในที่นี้ใชปาลม หนาที่ปาลมคือบันทึกขอมูลซึ่งได
รับจาก GPS ลงสูหนวยความจําลักษณะขอมูลที่ไดจะเปน Latitude และ Longtitude โดยต้ังชื่อเสน
ทางที่จะทําเสนทาง และระยะเวลาที่จะใหบันทึกเสนทาง เชน ชื่อ Setup ใหบันทึกทุกๆ 5 วินาที ซึ่ง
สามารถเปลี่ยนแปลงความเร็วในการบันทึกไดตามความเหมาะสมวาควรจะอยูในชวงใด 1 2 5 10 
หรือ 30 วินาที (ดังรูปที่ 5) ขอควรระวัง ควรใหแนใจวาโปรแกรมจัดทําบันทึกเสนทางไดรับ
สัญญานจาก GPS แลวจึงทําการบันทึกเสนทาง

วิธีการเซ็ตคา GPS ใหสงสัญญานออกไปยังโปรแกรมจัดทําบันทึกเสนทางกระทําไดดังนี้ 
ในที่นี้จะอางอิงถีง GPS Garmin รุน Etrex เทานั้น แตอยางไรก็ดีสามารถปรับใชกับ GPS ทุกรุนที่
สามารถปลอยสัญญาณGPS ที่เปน NMEA Standard (National Marine Electronics Association) 
ออกมาได ทั้งนี้ความละเอียดของขอมูลขึ้นอยูกับคุณภาพของ GPS แตละชนิด การเซต GPS ให
ความสําคัญอยูสองสวนหลักคือ สวน Units และ Interface สวน Units ใหเลือกใช LAT/LON หรือ 
hdd.dddd องศาใช DATUM Indian 1975 หนวยเปน METRIC และ North Reference เปน True 
สวน Interface ใหเลือก NMEA OUT และ Baud Rate 4800 BPS ซึ่งเปนความเร็วใน  การโอนถาย
ขอมูล ระหวาง GPS และ ปาลม
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รูปที่ 7 ภาพหนาจอหลักในการเซ็ตอัพ
เมื่อไดขอมูลการบันทึกเสนทางดวย GPS แลวจากนั้นนําขอมูลที่บันทึกเสนทางไดโอนเขาสูวินโดว
ผานทางสายเชื่อมตอของปาลม และทําการเปลี่ยนขอมูลที่อยูในรูปแบบของปาลมเปนรูปแบบ Text
file บนวินโดวโดยใช โปรแกรม Tracklog ซึ่งมีวิธีการทําดังภาพ

                                                      รูปที่ 8 การใชงาน TrackLog

นําไฟลดังการไปตัดสวนตางๆออกดวยโปรแกรม EXCEL แลวใหเหลือรูปแบบรูปแบบ
Latitude และ Longtitude ดังภาพ
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รูปที่ 9 Text File ซึ่งเปดดวย Excel

รูปที่ 10 ลักษณะไฟลที่พรอมสําหรับการสรางเสนทางใน AutoCAD Map
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จากนั้นเปดโปรแกรม AutoCAD Map เพื่อทําการนําขอมูลที่เก็บมาเพื่อทําการใหโปรแกรมสราง
เสนทาง โดยใชโปรแกรมชวย Dpoint.lsp (AutoLISP) เพื่อสั่งใหระบบทําการวาดเสนจากขอมูลที่
ไดเก็บมา รูปแบบไฟล Dpoint.lsp มีลักษณะดังนี้
เร่ิมตนไฟล ---� defun draw-point (name / fd rl)

    (setq fd (open name "r"))
   (command "pline")
   (while (setq rl (read-line fd))
      (command (princ rl))
    )
    (command "")
    (close fd)
)
(defun C:DPOINT ( / name)
    (setq name (getstring "\nFile name: "))
    (draw-point name)
    (princ)
)<---- สิ้นสุดไฟล ---------------

การทําใหโหลด Utility Dpoint.lsp เขาสู AutoCAD Map ทําไดโดยคําสั่ง “Load (Dpoint)” ซึ่งไฟล
Dpoint.lsp ตองอยูใน Support Directory ของ AutoCAD Map มิฉะนั้นจะไมสามารถโหลดใชงาน
ได เมื่อโหลดเสร็จก็สามารถเรียกใชคําสั่ง Dpoint แลวระบุไฟลที่จัดเตรียมไว เพื่อสั่งใหโปรแกรม
เขียนเสนทางตามไฟลที่ตองการ เปนอันสิ้นสุด (ดังภาพ)

รูปที่ 11 การใชคําสั่ง Dpoint ในการสรางเสนทาง
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รูปที่ 12 เสนทางเมื่อใชคําสั่ง Dpoint เสร็จสิ้นจะปรากฏดังภาพ
เนื่องจากเสนทางที่บันทึกดวย GPS ถูกบันทึกลงดวยขอมูล Latitude / Longtitude จึงมีความจําเปน
ตองเซ็ตพิกัดโลกใน AutoCAD Map ใหสัมพันธกับระบบพิกัดที่ไดรับมา โดยการใชคําสั่ง Map

-> Tools -> Assign Map Coordinate System ดังภาพ

รูปที่ 13 กําหนด Coordinate System Projection เปน THAI-W75
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จะสังเกตไดวา ระบบจะใชวิธีระบุ Coordinate System Projection ที่ใชมีอยูในการคนควาแบบอิสระ
คร้ังนี้มีอยูดวยกัน 2 Coordinate System คือ WGS84 Latitude / Longtitude,Degrees และ Thailand 
west of 102d East; Indian 1975 Datum รูปแบบ WGS84 Latitude / Longtitude,Degrees นั้นกําหนด
ใชเมื่อนําพิกัดที่ทําการบันทึกเสนทางมาใชใน AutoCAD Map เทานั้น แตการระบุแบบ และ 
Thailand west of 102d East; Indian 1975 ใชในการทํางานทั่วไปๆใน AutoCAD Map เนื่องจากวิธี
การระบุตําแหนงใน AutoCAD Map ระบุแบบพิกัดแนวตั้งแนวนอน (X and Y Coordinate System)
ซึ่งทําใหสะดวกในการทาํงานมากกวากาํหนดแบบอื่นๆการโอนถายขอมูลระหวาง Coordinate 
System โปรแกรมจะทําการแปลงใหอัตโนมัติ ซึ่งทําใหมีความสะดวกตอการทํางานเมื่อไดจัด
เตรียมขอมูลทั้งภาพถายทางอากาศที่ทําการซอยยอยเปนแผนๆและขอมูลเสนทางซึ่งจัดทําดวย GPS 
เสร็จสิ้นแลวการนําขอมูลทั้ง 2 ประเภทมารวมกันจัดทําไดโดยสรางไฟลซึ่งมีระบบ Coordinate 
System เปนแบบ Thailand Indian 1975 Datum จากนั้นใชคําสั่ง Insert External Reference เพื่อทํา
การนําเขาภาพเสนทางซึ่งจัดทําดวย GPS เขาสูระบบพิกัดใหมซึ่งจัดเตรียมไวแลว ระบบ 
Coordinate System จะทําการแปลงอัตโนมัติ

รูปที่ 14 หลักการทํา Rubber Sheet
หลักการคือยืดหรือหด จากจุดนั้นเขาไปยัง จุดที่อางอิง ซึ่งบางกรณีเรียกวิธีการแบบนี้วา
Registeration
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จาก WGS84 Datum Latitude / Longtitude,Degrees เปนระบบที่เซตไวในไฟลที่ใชงานอยูปจจุบัน
คือ Thailand west of 102d East; Indian 1975 สาเหตุที่ใชระบบ Coordinate เพราะเปนที่นิยมทั่วไป
เมื่อนําเขาขอมูลทั้งสองประเภทเขามาในไฟลแลวจากนั้นทําการปรับภาพถายทางอากาศใหเขาสู
พิกัดจริงของโลกซึ่งในที่นี้อางอิงกับเสนทางซึ่งบันทึกเสนทางโดยใชดาวเทียมนํารอง (GPS) โดย
ทําการทําจุดอางอิงแลวปรับเขาสูตําแหนงที่ถูกตองซึ่งเทคนิดนี้เรียกวา Rubber Sheet

รูปที่ 15 การเรียกใชคําสั่ง Rubber Sheet
ในกรณีนี้ ขอมูลภาพถายทางอากาศของเทศบาลเมืองเชียงใหม ถูกอางอิงกับสี่แยกหลักๆ ของวง
แหวนรอบนอกของตัวเมืองเชียงใหม อาทิ สี่แยกรินคํา สี่แยกขวงสิงห สี่แยกดอยสเก็ด สี่แยกสัน
กําแพง สี่แยกดอนจั่น และสี่แยกสนามบิน กลาวคือพยายามหาจุดอางอิงใหครอบคลุมพื้นที่ภาพถาย
ทางอากาศใหใกลเคียงความเปนจริงมากที่สุดเทาที่จะเปนไปได

การสงขอมูลออกสู MapGuide Server
การสงขอมูลออกมีอยู 2 ประเภทคือขอมูล Vector และ ขอมูล Raster ขอมูล Vector 

ประกอบดวย จุด เสน เสนรูปปด (point, line, Polygon) ในการสงออกไปยังเซิฟเวอรนั้นตองทําการ
ระบุประเภทขอมูลที่จะสงออกใหถูกตองวาเปนขอมูลประเภทใด และระบุพิกัดโลกที่จะสงออกให
ถูกตองดวย วิธีการคือ เลือก Menu Map ->Tools -> Export to Autodesk Mapguide ขอมูล Vector 
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ประกอบดวย จุด เสน เสนรูปปด (point, line, Polygon) ในการสงออกไปยังเซิฟเวอรนั้นตองทําการ
ระบุประเภทขอมูลที่จะสงออกใหถูกตองวาเปนขอมูลประเภทใด และระบุพิกัดโลกที่จะสงออกให
ถูกตองดวย วิธีการคือ เลือก

1. ขอมูล Vector ประกอบดวย จุด เสน เสนรูปปด (point, line, Polygon) ในการสงออกไป
ยังเซิฟเวอรนั้นตองทําการระบุประเภทขอมูลที่จะสงออกใหถูกตองวาเปนขอมูลประเภทใด และ
ระบุพิกัดโลกที่จะสงออกใหถูกตองดวย วิธีการคือ เลือก Menu Map ->Tools -> Export to
Autodesk Mapguide

รูปที่ 16 การสงออกขอมูล Spatial Data File (SDF)
ในการสงขอมูลออกนั้นสามารถเลือก ขอมูลที่จะสงออกไดโดยการเลือกเองหรือโดยการ
ใหโปรแกรมเลือกแบบอัตโนมัติได นอกจากนี้ยังสามารถเลือกแบบกําหนดชั้น (Layer) 

ÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
Copyright  by Chiang Mai University
A l l  r i g h t s  r e s e r v e d

ÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
Copyright  by Chiang Mai University
A l l  r i g h t s  r e s e r v e d



69

ของไฟลนั้นๆไดดวย เพื่อใหแนใจวาขอมูลที่สงออกเปนขอมูลที่ตองการ สามารถดูจาก 
Preview Filtered Object กอนสงออกไฟล Spatial Data File (SDF) อีกสวนหนึ่งที่จําเปน
ตองระบุคือระบบพิกัดที่ตองการจะสงออกวากําหนดใหเปนระบบพิกัดใดใหสอดคลองกับ
ระบบพิกัดบนเซิฟเวอรที่จัดทําในที่นี้ระบุเปนระบบพิกัดแบบ Thailand west of 102d East; 
Indian 1975 ในการสงออก

รูปที่ 17 เปนการกําหนดคุณสมบัติของไฟล SDF ที่ตองการสงออก
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นอกจากนี้กรณีที่ขอมูลที่ตองการสงออกมีฐานขอมูลเชื่อมตออยูก็สามารถสงรูปแบบของ Spatial 
Data File ในลักษณะที่มีขอมูลเชื่อมติดไปดวยไดเชนกันซึ่งจะเห็นไดในสวน Data Expression สวน
ที่จําเปนอยางยิ่งคือ Coordinate Coversion เพราะจะทําการแปลงขอมูลพิกัดปจจุบันเปนขอมูลพิกัด
ตามที่ระบุได มิฉะนั้นขอมูลจะไมตรงกับความเปนจริงที่เกิดขึ้นถาขอมูลพิกัดไมตรงกับ MapGuide 
Server เมื่อกําหนดคุณสมบัติตางๆเสร็จก็สามารถสงออก Spatial Data File ในรูปแบบนามสกุล 
.SDF ซึ่งพรอมนําไปใชงานไดการสงออกขอมูลที่เปน Raster ในที่นี้หมายถึงภาพถายทางอากาศนั้น
สิ่งสําคัญคือขอมูลพิกัดโลกอางอิงของแผนภ าพถายทางอากาศของแตละแผนภาพหรือไฟลตอง
สอดคลองกับเสนทางที่ทําการบันทึกเสนทางดวยระบบพิกัดนํารองดาวเทียม (GPS Tracking) การ
สงขอมูลภาพออกทําไดโดย เลือก Image -> Export -> World File

รูปที่ 18 การสงออกขอมูลพิกัดภาพถายทางอากาศ
หลังจากสงออกขอมูลพิกัดภาพถายทางอากาศเสร็จสิ้นก็จะไดกลุมของภาพถายและพิกัดอางอิงตาม
ความเปนที่สงออกจาก AutoCAD Map เนื่องจากภาพถายทางอากาศจําเปนตองมีความละเอียดใน
หลายระดับ ในการแสดงผล มาตราสวนที่ต่ํายอมนําเสนอภาพถายทางอากาศที่ละเอียด มาตราสวน
ที่สูง ยอมเสนอภาพถายทางอากาศที่ละเอียดนอย และแปรผันกับขนาดไฟลของภาพถายทางอากาศ
ดวยภาพที่มีความละเอียดสูงมีขนาดไฟลใหญเปนตน วิธีการทํากลุมภาพ ในระดับความละเอียด
ตางๆ ใชโปรแกรม Raster Workshop การสราง ในการสรางนั้นจะนําไฟลขอมูลพิกัดซึ่งสงออกมา
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จาก AUtoCAD Map ซึ่งมีชื่อวา Raster Image Catalog File (IRC) ซึ่งเปนไฟลบรรจุขอมูลภาพถาย
ทางอากาศและพิกัดอางอิง ดานลางซาย และดานขวาบนของภาพถายทางอากาศไวแลวเรียบรอย
ภายในเปนรายการ เมื่อตองการทํากลุมภาพที่มีความละเอียดต่ําลงก็เพียงแตนําไฟล Raster Image 
Catalog File (IRC) เขาสู Raster Workshop แลวทําการกําหนดความละเอียดของไฟลกลุมใหมที่
ตองการจากนั้นระบบก็จะจัดการให

รูปที่ 19 การนํา Raster Image Catalog File (IRC) เขาสู Raster Workshop
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รูปที่ 20 การกําหนด Sub Sample
การกําหนด Sub Sample คือการสรางกลุมไฟลใหมที่มีความละเอียดต่ํากวากลุมไฟลตนฉบับจุด
ประสงคคือการนําไปใชในการดูภาพที่ในระดับที่มาตราสวนสูงขึ้นใหแปรผันกับความละเอียดของ
ภาพถายทางอากาศ ในที่นี้ กําหนดใหเปน 100% 75% 50% และ 25% ตามลําดับ

การผสมผสานขอมูล Spatial Data File และ None Spatial Data file (Maguide Author)
ในสวนนี้จะกลาวถึงการทําเลเยอรและการเชื่อมขอมูลที่อยูในรูปฐานขอมูล เขากับ จุด เสน หรือ รูป
ปด ซึ่งการทํางานสวนนี้จะสัมพันธกับการเซต Mapguide Server เพราะตองเซตฐานขอมูลทั้ง
Spatial Data File และ None Spatial Data file ใหสัมพันธกันในการสราง กอนอ่ืนใน Mapguide
Server ตองระบุ Path ที่ถูกตองดังนี้
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                           รูปที่ 21 เปนการระบุ Directory ที่เก็บภาพถายทางอากาศ
จากรูปจะสังเกตเห็นไดวาเมื่อตองการมากกวาหนึ่ง Directory ใหขั้นดวย ; (semicolon)เพื่อสามารถ
ระบุ Path ไดมากขึ้นกรณีไฟลรูปภาพอยูตาง Directory และเชนเดียวกันกับการระบุ Data Source
Name ก็สามารถทําไดเหมือนกันคือการระบุ Path ที่เก็บ Spatial Data File ในรูปแบบ SDF ไวในที่
ตางๆก็สามารถระบุได กรณีนี้ตองระบุชื่อ Data Souce Name ที่ตองการจะติดตอดวย ซึ่งจะมีอยู 2
ลักษณะยอยคือขอมูลที่เกี่ยวขอกับฐานขอมูลและขอมูลที่ไมเกี่ยวของกับฐานขอมูล ซึ่งขอมูลที่เกี่ยว
ของจําเปนตองเรียกฐานขอมูลเพื่อเชื่อมตอกับ Spatial Data File เพื่อใชในการสรางความสัมพันธ
ระหวางขอมูลที่อยูในรูป  Spatial Data File และ None Spatial Data File เพื่อประโยชนในการใช
งานÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
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รูปที่ 22 กําหนดชื่อของ Data Source Name

รูปที่ 23  Spatial Data File เรียกใชฐานขอมูล
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รูปที่ 24 การเชื่อมตอ Spatial Data File เขากับ Data Source Name ผาน ODBC
ในกรณีไมเรียกใชฐานขอมูลเชื่อมตอกับ Spatial Data File ก็สามารถระบุเพียง Path ซึ่ง
Spatial Data File (SDF) นั้นๆอยู นอกจากนี้ในสวนอ่ืนๆของหนาคุณสมบัติของ Mapguide Server 
ยังระบุให กําหนด Logging เพื่อทําการตรวจสอบการใชงานของระบบ การกําลังสิทธิการเขาถึง 
โดยการกําหนดผูใชงาน (User) หรือกลุมของ (User Group) รวมไปถึงสิทธิที่มีขอจํากัดของแตละ
คนที่มีสิทธิ ยกตัวอยางเชน บุคคลนี้สามารถดูไดจากระดับมาตราสวน 1:10000 ถึง 1:5000 เทานั้น
เปนตน ทายสุดคือสวน Access Key คือสวนที่ปองกันการ เขาใชระบบ โดยการระบุคียในการเขา
และกําหนดชวงวันเลาที่อนุญาตใหเขาใชงานในระบบวาใหอนุญาตในชวงใดบาง
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รูปที่ 25 สวนจัดการคุณสมบัตของ Mapguide Server ในสวน Logging

รูปที่ 26 สวนจัดการผูใชงานหรือกลุมผูใชงาน
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รูปที่ 27 สวนจํากัดสิทธิการเขาถึงขอมูลระดับใดโดยอางอิงจากมาตราสวน
ในสวน Mapguide Author จะทํางานประสานกับ Mapguide Server ฉะนั้นการเซตคาตางๆใน 
Mapguide Server จะสงผลถึง Mapguide Author เมื่อมีการเรียกใชขอมูลที่แสดงใน MapGuide 
Author จะถูกตอง หรือผิดพลาดขึ้นอยูกับ Mapguide Server การระบุที่อยูที่ถูกตองของ Spatial Data 
File ไมวาจะเปน Vector หรือ Raster Format จะตองสมบูรณ รวมไปไปฐานขอมูลที่จะทําการเชื่อม
ตอตองถูกตอง และที่สําคัญคือระบบพิกัดที่ต้ังคาใน Mapguide Server ตองสัมพันธกับ ขอมูลที่สง
ออกมาจาก AutoCAD Map จากนั้นจึงเร่ิมตน จัดสรางความสัมพันธระหวาง Spatial Data File และ 
None Spatial Data File ภายใต MapGuide Author การสรางแผนที่ใน Autodesk Mapguide
จะจัดสรางในรูปแบบนามสกุล MWF (Map Window File) การเร่ิมตนดวยการสรางชั้นในการนํา
ไฟลขอมูล Spatial Data เขาสูแผนที่ในการสรางเลเยอรนั้นมี 2 รูปแบบใหญๆคือเลเยอรและกลุมเล
เยอร การสรางเลเยอรโดยปกติแลวจะแบงเปนขอมูล Vector และ Raster อันไดแก จุด เสน และเสน
รูปปด ภาพถาย และตัวหนังสือ ซึ่งขอมูลเหลานี้ถูกอางพิกัดไวแลวจากการสรางในตอนแรก ฉะนั้น
ขอมูลที่ถูกตองในตอนแรกจะมีความสําคัญมาก เพราะจะสงผลใหขอมูลที่ใชงานในสวน
ตางๆถูกตองไปดวยเชนกัน การสรางเลเยอรเร่ิมตนดวยการต้ังชื่อเลเยอร ต้ังชื่อที่ตองการใหแสดง
กรณีนี้ต้ังชื่อเลยเยอรวา “Building” และชื่อที่จะใหแสดงวา “อาคาร” แลวเลือกรูปแบบการแสดงผล
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รูปที่ 28 การสรางชั้น (Layer)
ของเลเยอรนั้นๆวา จะใหแสดงผลแบบใด แบบ Dynamic หรือ Static หมายถึงการกําหนดใหแผนที่
แสดงจุดนั้นๆ ตลอดเวลาหรือเปลี่ยนไปไปตามเงื่อนไขที่กําหนด สวน Make Map Features
selectable หมายถึงการอนุญาตใหผูใชงานเลือกใชขอมูลจุดนั้นๆได สวน Draw Priority หมายถึง
การกําหนดวาจะใหเลเยอรไหนวาดกอนหรือหลังโดยปกติแลว ปลอยใหเปนคาแกรมตั้งมาเปนตัว
จัดการ

รูปที่ 29 การกําหนดชื่อเลเยอรและการกําหนดคุณสมบัติตางๆ
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รูปที่ 30 การเชื่อมตอฐานขอมูลเขากับจุด
ในสวนนี้จะระบบ Data Source และตาราง รวมไปถึงฟลดที่ตองการอางอิงถึงนอกจากนี้การระบุ
ตําแหนงของจุดบนแผนที่เกิดจาก พิกัดที่เก็บไวในฐานขอมูลจึงจําเปนตองเรียกใชตําแหนงพิกัดดัง
กลาวในกรณีนี้เรียกใชฟลด LAT และ LON

รูปที่ 31 การเรียกใชพิกัดในฐานขอมูลเพื่อระบุตําแหนงบนแผนที่
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รูปแบบในการนําเสนอก็มีความสําคัญวาจะนําเสนอรูปแบบใดเชนการกําหนดมาตราสวน
ใหมองเห็นขอมูลเฉพาะชวงมาตราสวน หรือ อนุญาตใหมองเห็นทั้งหมด

รูปที่ 32 การกําหนดรูปแบบของขอมูลแบบจุด (Point)
กําหนดชวงของขอมูลก็จะสามารถแยกประเภทของขอมูลไดเชนเดียวกันวาขอมูลน้ันเปน
อาคารประเภทใด เชน อาคารบานพักอาศัย ศูนยการคา หรืออ่ืนๆ โดยการกําหนดหัวขอ
หลักที่ตองการอางอิงตามฐานขอมูล

รูปที่ 33 การกําหนดหัวขอหลัก ในการแสดงอาคารประเภทตางๆ
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ขั้นตอไปเปนการกําหนดภาพสัญลักษณใหกับจุดที่ไดกําหนดตามหัวขอหลักของอาคารวาชวงคานี้
ตองการรูปแบบอาคารแบบใด ตามไฟลสัญลักษณที่กําหนดใหหรือสรางสัญลักษณขึ้นใหมใหสอด
คลองกับความตองการ

รูปที่ 34 การกําหนดชวงคาเพื่อกําหนดประเภทอาคารและสัญลักษณ
ในการกําหนดรูปแบบสัญลักษณสามารถสรางสัญลักษณขึ้นใชเองไดหรือใชสัญลักษณมาตรฐานที่
มีอยูในโปรแกรม และกําหนดคุณสมบัติของสัญลักษณตามตองการ
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ภาคผนวก ค

องคประกอบของการสรางระบบสารสนเทศภูมิศาสตรประกอบดวย 3 สวนหลักๆคือ
1. สวนสราง หรือ สวนจัดทําขอมูลทางภูมิศาสตร สวนนี้จะประกอบดวยขอมูล 2 ประเภทคือ ขอ

มูลซึ่งอยูในรูป
จุด เสนสาย รูปปด (Point ,Line , Polygon) หรือที่เรียกกันทั่วไปวา Vector format และ ขอมูล
ซึ่งอยูในรูปภาพถายทางอากาศหรือ ที่เรียกกันทั่วไปวา Raster Format

1.1 ขอมูลที่อยูในรูป Vector format ไดมาจากการ บันทึกเสนทางดวย ระบบพิกัดนํา
รองดาวเทียมหรือที่เรียกกันทั่วไปวา GPS (Global Position System) ดวย
โปรแกรม Cetus และ จาก จุดหรือเสนสายที่สรางขึ้นใน AutoCAD Map รวมไป
ถึงพิกัดของจุด ที่สรางขึ้นดวยการระบุตําแหนงดวยพิกัดในฐานขอมูล

1.2 ขอมูลที่อยูในรูป Raster Format ไดรับการเอ้ือเฟอจากเทศบาลนครเชียงใหม แต
ทั้งนี้ภาพถายทางอากาศดังกลาวจําเปนตองมีการปรับแตงเพื่อใหเขากับตําแหนง
พิกัดจริงบนโลกดวยการใชเทคนิค Rubber Sheet โดยซอฟแวรชื่อ CAD Overlay
ทําการยืดตําแหนงเขาสูพิกัดที่ถูกตองซึ่งอางอิงดวย ระบบพิกัดนํารองดาวเทียม
(GPS) หลังจากนั้นขอมูลทั้งที่อยูในรูป Vector และ Raster format ก็พรอมที่จะถูก
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นําเขาไชงานในสวนตอไปโดยการสงออกผานขอมูลไปยังโปรแกรมจัดการขอมูล
สารสนเทศภูมิศาสตร

2. สวนจัดการขอมูลสารสนเทศภูมิศาสตร ประกอบดวย 3 สวนหลักคือ
2.1 สวนผสมผสานขอมูลที่อยูในรูปเชิงภูมิศาสตร (Spatial Data) และขอมูลซึ่งไมอยู

ในรูปเชิงภูมิศาสตร (None Spatial Data) กลาวคือสวนนี้ทําการสรางระบบสาร
สนเทศทางภูมิศาสตรจากขอมูลซึ่งไดรับจากสวนที่จัดสรางเสร็จ ใหอยูในรูปแบบ
ที่ตองการในการใชงาน สวนนี้เรียกวา MapGuide Author

2.2 สวนขับเคลื่อนขอมูลสารสนเทศภูมิศาสตร (GIS Engine) สวนนี้ทําหนาที่เปนเชิฟ
เวอรในการใหบริการ แกสวนที่ 3 คือสวนผูใชงาน และเปนสวนที่ทําหนาที่สื่อ
สารระหวาง Internet Information System (IIS) ในการใหบริการผูรองขอใช
บริการผานเครือขายอินเตอรเนต ซึ่งสวนนี้เรียกวา MapGuide Server

2.3 สวนเชื่อมตอโลกภายนอกผานเครือขายอินเตอรเนต Internet Information System
(IIS) สวนนี้ถือวาเปนสวนที่สําคัญที่ทําใหการเขาถึงขอมูลสารสนเทศภูมิศาสตร
ไมถูกจํากัดเพียงวงแคบๆ แตสามารถตอบสนองความตองการการใชงานผานเครือ
ขายอินเตอรเนตได แตก็ลืมเสียไมไดนั่นคือการกําหนดสิทธิการเขาถึงขอมูล ตอง
มีความรัดกุม สูงตามไปดวยเชนกัน

3 สวนผูใชงานนั้นประกอบดวย 2 สวนหลักคือ
3.1 โปรแกรมบราวเซอร มาตรฐานทั่วไป ซึ่งในกรณีนี้ใช Internet Explorer เปนหลัก

ซึ่งใชในการดูขอมูล แกไข อัพเดท สืบคน ซึ่งอาศัยความสามารถของเครื่อง
คอมพิวเตอรนอยมาก ฉะนั้นผูใชงานสามารถใชงานไดเพียงจัดหาเครื่องที่เชื่อมตอ
ระบบอินเตอรเนตไดและมีบราวเซอรมาตรฐานรองรับ

3.2 MapGuide Plug-in เปนโปรแกรมเสริมความสามารถของบราวเซอรปกติใหมี
ความสามารถใชงาน ขอมูลสารสนเทศภูมิศาสตร

จะเห็นไดวาทั้งสามสวนหลักทําหนาที่ของแตละสวน แลวสงขอมูลผานไปยังสวนถัดไปเพื่อให
บริการ ซึ่งแตละขั้นตอนของแตละสวนก็จะมีสวนยอย ในการจัดทํา รวมถึงวิธีการซึ่งไดมาซึ่งขอมูล
สารสนเทศภูมิศาสตร การผนวกขอมูลเชิงพื้นที่ (Vector and Raster) เขากับขอมูลซึ่งไมอยูในรูปพื้น
ที่อาทิ ขอมูลอาคารสถานที่ ขอมูล สถิติเชิงตัวเลข อ่ืนๆ แลวสรางสิ่งที่ตองการ ใหตอบสนองกับ
งานองคกร ในบางครั้งขอมูลที่ไดจากระบบ เปนความรูใหมที่อาจจะอยูนอกเหนือความคิดปกติซึ่ง
นี่ความสามารถหลักของ ระบบสารสนเทศภูมิศาสตร
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ภาคผนวก ง
การเชื่อมตอ Open Database Connectivity (ODBC)

การเชื่อมตอฐานขอมูลเขากับระบบภูมิศาสตรถือวาเปนสิ่งสําคัญอีกประการหนึ่งในการเชื่อมตอนั้น
จะกระทําที่ เชิฟเวอรหลัก เพื่อเชื่อมฐานขอมูลเขากับแผนที่ภูมิศาสตรและ เวบเชิฟเวอร (IIS) วิธี
เชื่อมตอกระทําโดย วินโดวเอ็นที 4.0 ขึ้น โดยไปที่ Start -> Setting -> Control Panel

รูปที่ 1 การเชื่อมตอ ODBC

เลือกที่เมนู System DSN เพื่อทําการสราง Data Source ใหม จากนั้นเลือก Add เพื่อทําการสราง
ทําการเลือก MySQL ODBC ในการเชื่อมตอฐานขอมูลจากนั้นคลิ๊กเลือก Finish แลวไปยังขั้นตอไป
ระบุชื่อฐานขอมูลที่ตองการตั้ง ระบุที่อยูของขอมูล  ในที่นี้ localhost หมายถึงเคร่ืองที่ใชอยูปจจุบัน
ซึ่งสามารถระบุเปน ไอพี แอดเดรส ได เลือก ชื่อฐานขอมูล ระบุชื่อและ รหัสผานผูใชงานและ
พอรตที่เชื่อมตอ คาปกติจะถูกเซตไวที่ 3306ÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
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รูปที่ 2  การเพิ่ม System Data Source Name (DSN)

รูปที่ 3 MySQL ODBC Driver
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รูปที่ 4 ระบุรายละเอียดในการเชื่อมตอ ODBC

จากนั้นทําการทดสอบ Data Souce วามีการเชื่อมตอสําเร็จหรือไมโดยการคลิ๊กที่ Test Data Souce
เพื่อทําการทดสอบ ซึ่งถาผลการทดสอบสําเร็จ Data Source ก็พรอมที่จะใชงานได

รูปที่ 5 ผลการทดสอบเชื่อมตอ Data Source สําเร็จ
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ภาคผนวก จ
การใช MySQL Administrator for Windows

เนื่องจากการสราง ตาราง ใน MySQL มีความยุงยากพอควรกรณีที่ผูใชงานไมคุนเคยกับ MySQL
ดังนั้น MySQL Administrator for Windows จึงถูกสรางขึ้นเพื่ออํานวยความสะดวกในการใชงาน
ไมวาจะเปนการสรางฐานขอมูล การสรางตาราง รวมไปถึงการเขาถึงฐานขอมูลรายชื่อผูใชงาน ฐาน
ขอมูล ก็สามารถจัดการไดงายยิ่งขึ้น เมื่อติดต้ัง MySQL เสร็จ จากนั้นก็คลิ๊กที่ MySQL dministrator
for Windows จะปรากฏ Sever list keyทําการปอน Server list key  เพื่อเขาเชื่อมตอกับ MySQL
Server

รูปที่ 1 ระบุ Server List Key เพื่อเชื่อมตอ MySQL

เมื่อระบุ Server List Key กด OK จากนั้นจะปรากฏหนาตางเพื่อทําการเพิ่มเชิฟเวอรเขาไป MySQL
Administrator เพื่อพรอมในการจัดการ ขั้นนี้โปรแกรมก็จะใหกรอกขอมูล ชื่อเชิฟเวอร ชื่อโฮสหรือ
ไอพีแอดเดรสที่ตองการเชื่อมตอ รวมไปถึงพอรตและ ชื่อ รหัสผานเพื่อเชื่อมตอ MySQLÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
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รูปที่ 2 รายละเอียดการเชื่อมตอ MySQL

รูปที่ 3 ทําการเชื่อมตอ MySQL Server
เมื่อทุกขั้นตอนไดทําเสร็จสิ้น ขั้นตอนสุดทายคือเลือกที่ Server ในที่นี้ชื่อ GIS จากนั้นกดปุมขวา
ของเมาสเพื่อทําการเชื่อมตอฐานขอมูล MySQL Database Server กับ MySQL Administrator for
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รูปที่ 4 สรางฐานขอมูลใน MySQL Server

Windows แตในกรณีเปนการเชื่อมตอฐานขอมูลในเครื่องเดียวกัน ถาเปนกรณีตางเชิฟเวอรก็
สามารถทําไดเชนเดียวกันโดยระบุเชิฟเว อรที่จะทําการเชื่อมตอดวยชื่อหรือ ไอพีแอดเดรสจากนั้น
ทําการสรางฐานขอมูลใหมใน MySQL Server ผานทาง MySQL Administrator โดยการคลิ๊กที่ 
Create a Database แลวระบุชื่อ ฐานขอมูลที่ตองการจะปรากฏชื่อฐานขอมูลขึ้นมา
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รูปที่ 5 การสรางตารางในฐานขอมูล

เมื่อสรางฐานขอมูลเสร็จก็ทําการสรางตารางในฐานขอมูลในกรณีนี้สรางฐานขอมูล Account จาก
นั้นตาราง account ก็จะปรากฏในฐานขอมูล mapdb เมื่อตองการเพิ่มเติมแกไขตารางก็สามารถ
กระทําไดโดย กดปุมขวาของเมาสแลวทําการเลือก Table maintenance
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รูปท่ี 6 การปรับปรุงแกไขตาราง

รูปที่ 7 ตารางที่สามารถปรับปรุงแกไขขอมูลตางๆ
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ในการสรางเลเยอรที่เปนภาพถายหรือ Raster นั้นสามารถทําไดดังนี้สรางเลเยอรโดยกําหนดเปนเล
เยอรหรือกลุมเลเยอร (Group Layer)

รูปที่ 35 การสรางกลุมเลเยอร
การสรางกลุมเลเยอรเพื่อจุดเลเยอรอยูในกลุม เชนกลุมเลเยอรของภาพถายทางอากาศซึ่งมีมาตรา
สวนในการมองเห็นที่แตกตางกันในแตละมาตราสวน

รูปที่ 36 การกําหนดเลเยอรในกลุมเลเยอรหลักในรูปแบบ Raster Layer
จากรูปเปนการกําหนดขอมูลเลเยอรภาพถายทางอากาศ ซึ่งมีขนาดมาตราสวนที่กําหนดใหมองเห็น
ไดในระดับมาตราสวน 1:2000 จนถึง 1:5000 หนวย ซึ่งการแบงกลุมความละเอียดในการมองเห็น
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ภาพถายทางอากาศจะชวยลดการทํางานของเชิฟเวอรในการประมวลผลและสงผลถึงความเร็วใน
การเขาถึงขอมูลในระบบอีกดวย

รูปที่ 37 การระบุไฟลที่เก็บขอมูลภาพถายทางอากาศ
ขอมูลภาพถายทางอากาศถูกกําหนดดวย Raster Image Catalog File (IRC) ใน IRC ไฟลจะระบุ
Path  ของไฟลภาพถายทางอากาศและพิกัดอางอิงมุมลางซาย และขวาบนของภาพถายทางอากาศ
ตลอดจนคุณสมบัติของภาพถายทางอากาศนั้นๆวามีคุณสมบัติอยางไร

รูปที่ 38 การกําหนดชวงมาตราสวน
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รูปที่ 39 การกําหนดชวงมาตราสวนที่ตองการใหสามารถมองเห็นไดในแผนที่
ภาพถายทางอากาศจะถูกกําหนดให สรางใหมไดตามสัดสวนการยอขยายที่กําหนดในสวนทายสุด
ของการสรางเลเยอรทุกชนิดก็จะมีสวนการักษาความปลอดภัยในเลเยอรนั้นๆ ในการปองการ การ
เขาถึงเลเยอร จะมีรหัสผานหรือไม ก็ไดถาตองการใหมีรหัสผานก็ใส Access Key เขาไปในสวน 
Security ของเลเยอร เมื่อมีการเรียกใช Layer นั้นๆแผนที่ก็จะถามรหัสผานจากผูใชงานเพื่อเขาใจเล
เยอรดังกลาว

คุณสมบัติหลักของแผนท่ีสารสนเทศทางภูมิศาสตร
คุณสมบัติหลักของแผนที่สารสนเทศทางภูมิศาสตร เพื่อการแจงขาวและสถิติอาชญากรรม

ของตํารวจภูธรเชียงใหมมีองคประกอบดังนี้

รูปที่ 40 บริเวณกําหนดคุณสมบัติทั่วๆไปของแผนที่
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ประกอบดวย ชื่อแผนที่ พื้นสีหลัง ตลอดจนบริเวณพื้นที่ ที่ตองการแสดงภาพแผนที่ หนวยที่ใชใน
แผนที่เปน Metric ซึ่งกําหนดไดใน Preference ของแผนที่หลักโดยการเลือก File -> Preference
จากนั้นระบุหนวยที่ใชเปน Metric การระบุตําแหนง Mouse Position ก็สามารถเลือกไดเชนกันโดย
การเลือกแบบ Latitude / Longtitude หรือ UTM ที่สรางจากไฟลตนฉบับใน AutoCAD MAP
การกําหนดพิกัดมีขอควรระวังพิกัดตองสอดคลองกับตนฉบับที่สรางเชน ภาพถายทางอากาศถูก
สราง Raster Image Catalog File เปน WGS 1984, UTM Zone 47 North ในแผนที่ก็ตองถูกต้ังหนวย
ของพิกัดใชแบบเดียวกัน จะไมเกิดปญหาขอมูลภาพถายทางอากาศ ไมแสดงผลเพราะแสดงผลไม
ตรงตามตําแหนงที่ควรจะเปนในแผนที่

รูปที่ 41 การเซตคา Coordinate System ProjectionÅÔ¢ÊÔ·¸Ô ìÁËÒÇÔ·ÂÒÅÑÂàªÕÂ§ãËÁè
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การสรางรายงานจากวัตถุที่เลือกในแผนที่ หลักการคือ เลือกวัตถุบนแผนที่นําคาที่ไดจากวัตถุไปสืบ
คนขอมูลในฐานขอมูลที่เชื่อมตอกับวัตถุนั้นๆ เชน จุดนี้คือพิกัดเทาใด แลวสืบคนหาชื่ออาคาร หรือ
ขอมูลอ่ืนๆซึ่งเกี่ยวของสัมพันธกับอาคารนั้นๆ

รูปที่ 42 การทํารายงานจากวัตถุ (Object)
การยอหรือขยายไปยังตําแหนงที่ตองการ ก็เปนสวนสําคัญอีกกรณีหน่ึงในการคนหามีวิธีการคลาย
กับการสืบคนใน SQL Command แตเปนการคนในเชิงวัตถุโดยอางอิงจากพิกัดในฐานขอมูล

รูปที่ 43 การยอขยายไปยังสวนที่ตองการ (Zoom Goto)
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สวน Popup Menu เปนสวนเสริมเพื่อสรางความสะดวกในการใชงานแผนที่ วิธีการใชเพียงกดปุม
ขวาของเมาสบนแผนที่จะปรากฏ PopUp Menu ขึ้นเพื่อใหเลือกใชงานตามตองการไดเมื่อเลือกใช
งานโปรแกรมก็จะทํางานตามที่ Action ที่ถูกกําหนดใน PopUP Menu วาใหทําอะไรบาง

รูปที่ 44 การแกไขเปลี่ยนแปลง Action สวน PopUP Menu
สวนรักษาความปลอดภัยของแผนที่หลัก เพื่อปองกันการเขามาแกไขเปลี่ยนแปลงคุณสมบัติตางๆ
ในแผนที่สวนนี้ถือวาเปนสวนสําคัญ เนื่องจากผูใชสามารถเขามาแกไขคุณสมบัติตางๆในแผนที่ได
ทั้งหมดถาทราบ Access Key หลักของแผนที่นี้
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รูปที่ 45 สวนปองกันความปลอดภัยของแผนที่หลัก

บทสรุปการไดมาซึ่งขอมูลสารสนเทศทางภูมิศาสตร
การไดมาซึ่งขอมูลสารสนเทศทางภูมิศาสตรนั้นไดมาจาก 2 สวนหลักคือขอขอมูลซึ่งอยูใน

รูป Vector และขอมูลซึ่งอยูในรูป Raster หรือที่เรียกกันวา (Spatial Data file) การนําขอมูลเขานั้น
ประกอบ 2 วิธีการคือการนําผานเครื่องอานพิกัดดาวเทียม (GPS) แลวการ Insert ขอมูลเขาตรงๆใน
AutoCAD MAP ซึ่ง AutoCAD Map ถือวาเปนสวนสรางแผนที่ จากนั้นทําการปรับแตงพิกัดใหเขา
กับตําแหนงจริงของโลก เลือกใช Coordinate Projection System ที่เหมาะสมกับพื้นที่ ในที่นี้เลือก
ใช Thailand west of 102d East; Indian 1975 Datum / และ Latitude / Longtitude  WGS 1984 เปน
Coordinate Projection System เมื่อขอมูลพรอมที่จะสงออกก็จัดการสงออกไปยัง MapGuide Server
เพื่อทํางานในขั้นตอนตอไป ขั้นนี้ก็เซตคาตางๆที่เกี่ยวของกับ SDF File และ Raster file
กําหนด Path และ ฐานขอมูลที่จะเชื่อตอใหถูกตองกอน เรียกใชขอมูลโดย Mapguide Author ซึ่ง
เปนสวนสุดทายในการจัดการระบบสารสนเทศทางภูมิศาสตร ในการสรางสิ่งตอบสนองความ
ตองการของผูใชระบบในรูปแบบตางๆ ในที่สุด จากนั้นก็นําเสนอตอผูใชงาน.
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ภาคผนวก ข
การเชื่อมตอ Autodesk MapGuide กับ Internet Information Server

การเชื่อมตอ AutoDESK MapGuide Server กับ Internet Information Server (IIS)

จุดประสงคเชื่อมตอระบบเพื่อสามารถรองรับการใชงานในระบบเน็ตเวอรคได ซึ่งอาจเปนเครือขาย
เฉพาะที่ LAN หรือแมกระทั่งระบบอินเตอรเนต (WAN) การเชื่อมตอระบบอินเตอรเนตอาศัยความ
สามารถของ IIS แตความสามารถของระบบแผนที่อาศัยความสามารถของ MapGuide Server วิธี
การเปด IIS จากนั้นสราง Virtual directory ดังภาพที่แสดง จุดสําคัญคือ ระบุให Virtual directory
ดังกลาวใหมีคุณสมบัติ Execute ไดเพื่อเรียกใชความสามารถของ MapGuide Server ที่เรียกวา
MapAgent เมื่อเสร็จขบวนการนี้ระบบก็พรอมที่ใหบริการระบบสารสนเทศภูมิศาสตร
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ภาคผนวก ฉ

คูมือการใชงาน
ระบบสารสนเทศภูมิศาสตรเพื่อการแจงความและสถิติอาชาญากรรม

 ของตํารวจภูธรจังหวัดเชียงใหม

ระบบที่พัฒนาขึ้น ไดพัฒนาขึ้นเพื่อตอบสนองความตองการ การใชระบบสารสนเทศใน
การปองกันปราบปรามอาชญากรรม ตลอดถึงการวางแผนจัดการในดานอ่ืนๆที่เกี่ยวของ ทั้งคดี
อาญาทั่วไป และคดีจราจร ของตํารวจภูธรจังหวัดเชียงใหม ซึ่งระบบพัฒนาขึ้นเพื่อรายงานผล สืบ
คนขอมูลผลการรายงาน เชื่อมโยงกับขอมูลทางภูมิศาสตร รวมไปถึงการมีสวนรวมของประชาชน
ในการแจงขาวหรือเบาะแสอันเปนประโยชน ตอเจาหนาที่ ภายในเขตเทศบาลนครเชียงใหม

1. ความตองการของระบบและการใชงานทั่วไป
ระบบสารสนเทศภูมิศาสตรเพื่อการแจงความและสถิติอาชาญากรรมของตํารวจภูธรจังหวัด
เชียงใหม มีลักษณะเปน Client <-> Server ในที่นี้จะกลาวถึง Client ความตองการของฝงผูใช
งานนั้น ตองมี Browser มาตรฐานทั่วไป ซึ่งขอแนะนําใหใช Internet Explorer 6.0 ขึ้นไป
และมี MapGuide Plug-in ติดต้ังที่ Browser ดังกลาวเพื่อสนับสนุนการใชงานแผนที่แบบ
Dynamic และมีระบบเนตเวอรคที่เชื่อมตอยัง MapGuide Server เพื่อทําการเรียกใชระบบ ใน
กรณีตองการสั่งพิมพรายงาน จําเปนตองมีเคร่ืองพิมพ ติดต้ังดวย ขอแนะนําเปนเคร่ืองพิมพสี
หรือ เลเซอรปรินซเตอร เมื่อติดต้ัง Plug-in และเชื่อมตอระบบกับเชิฟเวอรแลว ก็เปด URL        
(Universal Resource Locator) ในชองบราวเซอร จากนั้น คลิ๊กที่ ระบบสารสนเทศมิศาสตร

รูปที่ 1 URL ของระบบสารสนเทศภูมิศาสตร
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เมื่อกดที่ ระบบสารสนเทศภูมิศาสตร จะปรากฏหนาหลักของระบบสารสนเทศภูมิศาสตรเพื่อการ
แจงความและสถิติอาชญากรรม ดังนี้

รูปที่ 2 หนาจอหลักของระบบสารสนเทศภูมิศาสตรเพื่อการแจงความและสถิติอาชญากรรม
การใชงานระบบจะแบงออกเปน 2 สวนหลักๆคือภาคประชาชนทั่วไป และเจาหนาที่

ตํารวจผูรับผิดชอบ ในกรณีประชาชนทั่วไปสามารถ เลือกปุมประชาชน เพื่อเขาไปใชระบบไดทัน
ทีแตในกรณีที่เปนเจาหนาที่ตํารวจจะตองมีรหัสผานเพื่อเขาใชระบบดังกลาว

2. การใชงานกรณี ประชาชนทั่วไป
ในกรณีประชาชนทั่วไป สามารถเขาใชงานไดทันทีโดยไมมีรหัสผานใดๆ เพื่อเขาไปแจงขาวหรือ
เบาะแส เสนอแนะ ขอมูลอันเปนประโยชน ตอเจาหนาที่ตํารวจ ซึ่งเมื่อเลือกกดตรง
ประชาชน ก็จะปรากฏหนาตางใหมขึ้นมา ซึ่งหนาตางจะประกอบดวย 3 สวนหลักๆคือสวนซายมือ
คือสวนแผนที่ภูมิศาตร สวนขวามือเปนสวนคําแนะนําการใชงานระบบ และสวนดานลางกรอกขอ
มูลเพื่อแจงขาว หรือเบาะแส คําแนะนําตางๆ  ซึ่งการเขาสูระบบในครั้งแรกโดยไมมีการติดต้ัง Plug-
in จะทําใหสวนแผนที่ไมสามารถเห็นแผนที่ได แตจะมีคําแนะนําในชองดานซายมือ ใหติดต้ัง Plug-
in ซึ่งสามารถทําไดโดยการโหลดไปตัดต้ังเอง หรือใหติดต้ังอัตโนมัติในบราวเซอรของผูเรียกใชก็
ได โดยกดเลือกกดหัวขอที่ตองการวาจะติดต้ังแบบใดในชองดานซายมือไดทันที ซึ่ง การติดต้ัง
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Plug-in จะใชเวลานานหรือไมขึ้นอยูคุณภาพสายในการเชื่อมตอระบบวามีความเร็วเพียงโดยปกติ
การติดต้ังแบบอัตโนมัติ ใชเวลาไมเกิน 5 นาที ที่ความเร็วในการเชื่อมตอเนตเวอรคโดยใชความเร็ว
โมเด็ม 56 Kbps หรือการโหลดไป Plug-in เพื่อการติดต้ังดวยตนเอง ใชเวลาไมเกิน 15 นาทีในคุณ
ภาพการเชื่อมตอเดียวกัน ในสวนดานลางของจอภาพจะเปนคําแนะนําทั่วไป ในการใชงานของ

ประชาชนทั่วไป วามีวิธีการใชงานอยางไร ดังนี้
กรุณากรอกขอมูลขางลางนี้ตามความเปนจริง เพื่อประโยชนในการปฏิบัติงาน
ไดอยางสะดวก รวดเร็ว และจะเก็บขอมูลดังกลาวเปน ความลับ
1. กรอกชื่อ ที่อยู หมายเลขโทรศัพท อีเมล ใหชัดเจน เพื่อความสะดวกในการติดตอกลับ
2. ในกรณีทานตองการระบุตําแหนงบนแผนที่ ขยายมาตราสวน 1:2000 - 1:4000 ณ.บริเวณ    
              ตําแหนงที่เกิดเหตุ จากนั้นระบุตําแหนง ซึ่งคาพิกัด (LAT/LON) จะปรากฏในฟอรม
3. ในกรณีทานไมตองการ ระบุตําแหนงทานสามารถขามขั้นตอนนี้ไปได
4. ระบุประเภทขอมูลที่แจง เชน ฆาตกรรม, ลักขโมย, ยาเสพติด, ลวงเกินทางเพศ อ่ืนๆ
5. กรอกรายละเอียดที่ตองการแจงใหชัดเจนที่สุดเทาที่จะเปนไปได
6. กดปุมแจงขอมูล เมื่อขอมูลพรอมสง
7. ระบบไดรับขอมูลระบบจะตอบกลับมายังผูแจงตามอีเมล แลวรอขบวนการทํางานตอไป

รูปที่ 3 ภาพหนาจอการการแจงขาว
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เมื่อติดต้ัง Plug-in เสร็จ Browser ก็จะสามารถใชงานระบบแผนที่ภูมิศาสตรได สังเกตุไดโดย
การมองเห็นภาพแผนที่ภูมิศาสตรที่ปรากฏ ขอบเขตของแขวงตางๆในเขตเทศบาลนคร
เชียงใหม นั่นหมายถึง Browser ของผูใชงานสามารถใชงานระบบไดแลว

รูปท่ี 4 การแจงขอมูล เบาะแสและคําแนะนําตางๆ

การแจงขอมูลกระทําโดยกดปุม เขาใชระบบ และขยายแผนที่ บริเวณจะแจง กรอกรายละเอียดตางๆ
ซึ่งชองรายละเอียด และประเภทขอมูลการแจง ตองระบุ กรณีตองการระบุในแผนที่แผนที่ที่จะทํา
การระบุ จะตองมีมาตราสวนอยูระหวาง 1:2000 ถึง 1:4000 เทานั้นเพื่อความแมนของการระบุสถาน
ที่ อันจะสงผลงายแกการตรวจสอบแกเจาหนาที่ผูรับผิดชอบ สวนขอมูลอ่ืนๆ ถาตองการระบุก็
สามารถระบุได แตถาไมตองการระบุก็สามารถเวนวางไวไดเชนกัน
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รูปท่ี 5 ระบบจะตอบรับเมื่อระบบไดรับขอมูลการแจงเบาะแสเรียบรอยแลว

รูปท่ี 6 ท่ีมาของระบบ และ วิธีการใชงานปุมและ Popup Menu
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วิธีการใชงานปุมตางๆในแผนที่

  สั่งพิมพแผนที่ออกทางเครื่องพิมพ เลื่อนแผนที่

  กอปป แผนที่ลงคลิปบอรด ยอแผนที่ตามคาแรก
ขยายแผนที่ วิธีการใชงานปุมตางๆและเมนูยอย
ยอแผนที่ ความเปนมาเกี่ยวกับระบบ

  กลับไปหนาหลัก

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
Print พิมพแผนที่
Copy กอปปแผนที่
Zoom ยอ/ขยายแผนที่
Bookmarks บันทึกตําแหนง
Select เลือกวัตถุบนแผนที่
View ดูขอมูลตางๆ
Help คําแนะนําตางๆ และเซตคาพิกัด

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
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วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
Print พิมพแผนที่
Copy กอปปแผนที่
Zoom ยอ/ขยายแผนที่
Bookmarks บันทึกตําแหนง
Select เลือกวัตถุบนแผนที่
Select เลือกวัตถุบนแผนที่

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
Print พิมพแผนที่
Copy กอปปแผนที่
Zoom ยอ/ขยายแผนที่

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม

วิธีการใชงาน Popup Menu
Pan เลื่อนแผนที่
Reload เรียกแผนที่ใหม
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3. การใชงานกรณี เปนเจาหนาที่ตํารวจผูรับผิดชอบ

                                      รูปที่ 7 หนาตางตรวจสอบสิทธิกอนเขาสูระบบ

การใชงานเร่ิมตนโดยเลือกหัวขอ เจาหนาที่ตํารวจ จากนั้นจะปรากฏหนาตางในการเขาสู
ระบบเพื่อใหผูใชงาน ตรวจสอบสิทธิในการใชงานกอนเขาสูระบบ จากนั้นกด Submit เพื่อ
ตรวจสอบกรณีมีรายชื่ออยูในระบบ ก็จะผานเขาไปใชงานไดตามปกติ แตถาไมมีรายชื่ออยู
ในระบบ หรือรหัสผานผิดระบบก็จะแจงกลับ เพื่อใหทําการปอน รายชื่อ และรหัสผานที่
ถูกตองใหม

กรณีรายชื่อผานก็จะปรากฏ หนาตางดังรูปที่ 8 ประกอบดวย 3 สวนหลักๆคือ สวนเมนู สวนราย
ละเอียดและสวนสุดทายเปนสวนแสดง แผนที่ภูมิศาสตร

สวนเมนูหลัก จะแบงผูใชออกเปน 3 กลุมคือ ผูใชที่เปนเจาหนาที่บันทึกขอมูล ซึ่งทํา
หนาที่บันทึกขอมูล คดีจราจร คดีอาญาทั่วไป บันทึกตําแหนงอาคารสถานที่สําคัญๆ กลุมที่ สองคือ
กลุมผูบริหาร มีความสามารถเพิ่มขึ้นที่จะคนขอมูลตางๆได อาทิ ขอมูลคดีอาญา ขอมูลคดีจราจร
ขอมูลอาคารสถานที่ ขอมูลการแจงเบาะแสตางๆ จากภาคประชาชน รวมไปถึงความสามารถที่จะ
เขาใชสวน วิเคราะหแผนที่ ซึ่งเปนสวน วิเคราะหและตัดสินใจ ในการจัดการงานของตํารวจภูธร
จังหวัดเชียงใหม
กลุมที่ 3 คือกลุมผูจัดการระบบ ถือวาเปนกลุมที่มีสิทธิสูงสุด ในการจัดการระบบ สิ่งที่เพิ่มเติมจาก
กลุมที่ 2 คือสิทธิในการจัดการ รายชื่อผูใชงานในระบบ เชน เพิ่มรายชื่อ ลบรายชื่อ เปลี่ยนแปลงขอ
มูล ของรายชื่อในระบบ และสวนที่เปนขาวสารซึ่งสงถึงผูใชงานระบบซึ่งเปนอักษรวิ่ง
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สวนรายละเอียด จะขึ้นอยูกับรายการเมนูที่ถูกเลือกวา สั่งใหทํารายการใด เชน บันทึกคดี
จราจร บันทึกคดีอาญาทั่วไป เปลี่ยนรหัสผาน เปนตน

สวนแสดงขอมูลแผนท่ีภูมิศาสตร เปนสวนแสดงขอมูลตามที่ผูใชงานเลือก เชน การยอ
ขยาย การแสดงหรือไมแสดง วัตถุตางๆบนแผนที่ถูกกําหนดดวย ชั้นของแผนที่ (Layer) รวมไปถึง
การสืบคนขอมูลตางๆ แลวใหแสดงผลการสืบคนในแผนที่ดวย

รูปท่ี 8 รูปหนาตางหลักเมื่อผานเขาสูระบบ
จากรูปที่ 8 เปนหนาหลักของผูใชงานที่เปนกลุมเจาหนาที่ตํารวจซึ่งจะแตกตางกันที่ รายการเมนู วา
รายชื่อใดมีสิทธิเทาใดในการใชงานระบบ สวนลางของหนาตางเปนสวนคําอธิบายในการใชงานใน
การบันทึกขอมูลคดี เพื่อสรางความเขาใจตอผูใชงานระบบ
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รูปท่ี 9 รูปการรายงานขาวคดีจราจร
การรายงานขาวคดีจราจรกระทําไดโดย กดเลือกเมนู บันทึกขอมูลคดีจราจร จากนั้นจะ
ปรากฏรายละเอียดตางๆใหปอน ซึ่งในสวนนี้จะมีสวนที่เปนพิเศษคือการระบุตําแหนงบน
แผนที่ ซึ่งกระทําไดโดยการขยายแผนที่ไปยังตําแหนงที่เกิดคดีจราจรใน มาตราสวนอยู
ระหวาง 1:2000 ถึง 1:4000 เพราะถาไมอยูในมาตราสวนนี้ระบบจะรายงานวา ใหขยายใน
ชวงมาตราสวนดังกลาว เมื่อมาตราสวนถูกตองก็ทําการระบุตําแหนงบนแผนที่ เพื่อระบุ
ตําแหนง จากนั้นขอมูล ละติจูด ลองติจูด ก็จะปรากฏในชองของรายละเอียด เพื่อบันทึก
ตําแหนงดังกลาวลงสูฐานขอมูล กรณีไมทราบตําแหนงที่เกิดเหตุสามารถขามขั้นตอนนี้ไป
ไดเชนเดียวกัน เมื่อปอนรายละเอียดตางๆครบก็ทําการ กดปุม Submit เพื่อบันทึกขอมูลคดี
จราจรเขาสูฐานขอมูล และจะปรากฏ คําตอบรับจากระบบวาไดบันทึกเสร็จแลว และ
สามารถทําการบันทึกใหมหรือ เลือกเมนูอ่ืนๆเพื่อใชงานตอไป

ในกรณีที่เปนการบันทึกขอมูลคดีอาญาทั่วไป บันทึกขอมูลอาคาร ก็ทํางานในลักษณะเดียว
กันกับการบันทึกขอมูลคดีจราจร ซึ่งจะแตกตางกันเฉพาะรายละเอียดของขอมูลที่จะทําการบันทึก
ลงในฐานขอมูลเทานั้นเอง
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รูปที่ 10 การบันทึกขอมูลคดีอาญาทั่วไป (บน)  รูปที่ 11 การบันทึกขอมูลตําแหนงอาคาร (ลาง)
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รูปท่ี 12 การตอบรับการบันทึกขอมูลอาคาร และ การเปลี่ยนรหัสผาน
เมื่อขอมูลที่ถูกบันทึกลงฐานขอมูลระบบจะตอบรับวาไดบันทึกขอมูลเปนที่เรียบรอยแลว พรอมที่
จะบันทึกขอมูลตอไป การเปลี่ยนรหัสผานก็ทําไดโดยกดที่เมนูเปลี่ยนรหัสผาน แลวจะปรากฏหนา
ตางดังรูปที่ 12 จากนั้นปอนรหัสเดิม และปอนรหัสใหมที่ตองการ เพื่อเปลี่ยนรหัสผาน จากนั้น
ระบบจะใหเขาสูระบบใหมอีกคร้ัง

ในการสืบคนขอมูลเปนสิทธิของเจาหนาที่ตํารวจระดับบริหารและผูจัดการระบบเทานั้นที่
จะสามารถใชงานในสวนนี้ได รูปแบบการทํางานทําไดโดยเลือก เมนู สืบคนขอมูลจากระบบ จะ
ปรากฏรูปดังรูปที่ 13 จากนั้นเลือกประเภทขอมูลที่ตองการสืบคน คือ ขอมูลคดีอาญาทั่วไป ขอมูล
คดีจราจร ขอมูลอาคารสถานที่  และขอมูลการแจงเหตุ หรือขอมูลการแจงเบาะแสจากประชาชน
เมื่อเลือกประเภทขอมูลเสร็จก็จะปรากฏรายละเอียดขอมูล ที่จะสืบคน ไปตามลําดับขั้น ในกรณีที่มี
ความตองการสืบคนในรายละเอียดปลีกยอยก็จะมียอยลงไปเรื่อยๆ ในกรณีเลือกปลีกยอย อ่ืนๆ ก็จะ
ปรากฏชองใหปอนคําสําคัญในการคน (Key Word) ลงไปเพื่อสืบคน
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กรณีตองการคนมากกวา 1 เงื่อนไข ก็สามารถระบุ และ หรือ เพื่อเชื่อมคําสําคัญในการสืบคน ซึ่งจะ
ไดขอมูลที่จงเจาะลงไปซึ่งเงื่อนไขที่ใหเชื่อมเงื่อนไขมี 5 เงื่อนไข อาจจะระบุแตกตางกันไปแลวแต
จุดประสงค ของผูทําการสืบคนขอมูลจากฐานขอมูล เมื่อเงื่อนไขขอมูลที่ทําการสืบคนพรอมก็กด
ปุม สืบคน เพื่อทําการคนขอมูลดังกลาว กรณีมีขอมูลก็จะปรากฏรายการขอมูลขึ้นมา พรอมกับ
ปรากฏ ขอมูลตําแหนงบนแผนที่ วาขอมูลที่สืบคนอยูตําแหนงใดของแผนที่ภูมิศาสตร นอกจากนี้
ผลที่ไดจาการสืบคน สามารถดูรายละเอียดของขอมูลดังกลาวได ซึ่งแสดงเปนรายงานในแตหัวขอๆ
เรียงกันไป กรณีมีการแสดงผลมากเกิน 10 รายการสืบคน ระบบก็จะแสดงผลทีละ 10 รายการเรียง
เปนหนาๆไปเร่ือยๆจนครบทุกรายการ

รูปท่ี 13 การสืบคนขอมูลจากฐานขอมูล
ในการสืบคนขอมูลในฐานขอมูลน้ันผูสืบคนสามารถที่จะ เลือกชั้นเลเยอรที่ตองการแสดงหรือไม
แสดงไดดวยตนเอง เพื่อความสะดวกในการมอง แตการสืบคนในหัวขอน้ันๆ ชั้นที่เกี่ยวของจะทํา
การเปดตัวเองโดยอัติโนมัติเพื่อแสดงรายการบนแผนที่ ซึ่งจะสัมพันธ กับผลการสืบคนที่ผูคนสืบ
คน
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ลักษณะการแสดงผลรายละเอียดหลังจากการสืบคนจะปรากฏดังรูปที่ 14

รูปท่ี 14 การรายงานรายละเอียดของคดีอาญาหลังผลการสืบคนขอมูล

ผลจากการรายงานรายละเอียด จะแสดงแผนที่และรายละเอียดของขอมูลน้ันๆ ที่ผูใชสืบคน สวน
แผนที่จะปรากฏสัดสวนของมาตราสวนอยูที่ 1:3000 รอบบริเวญจุดเกิดเหตุนั้นๆซึ่งสามารถนําไป
งานไดโดยเทียบมาตราสวนที่ถูกตองเขากับระบบแผนที่.
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กรณีผูใชที่เปนผูจัดการระบบจะปรากฏเมนูยอย จัดการผูใชในระบบ เพื่อทําการ เพิ่ม ลบ หรือ
ทําการแกไขเปลี่ยนแปลงขอมูล ของผูใชในระบบ จะมีลักษณะดังนี้

รูปท่ี 15 การจัดการผูใชในระบบ
ในการจัดการผูใชในระบบนั้น มี 3 สวนหลักคือ เพิ่ม แกไขขอมูล และ ลบรายชื่อ ออกจาก
ระบบ การเพิ่มรายชื่อทําไดโดยการปอนชื่อ เลือกระดับชั้นในการกําหนดสิทธิการใชงาน ปอน
รหัสผานจากนั้นปอนชื่อ สกุล ตําแหนง และรหัสประจําตัวของเจาหนาที่ตํารวจที่จะปอน เมื่อ
เสร็จก็ทําการ Submit เพื่อบันทึกขอมูล การแกไขขอมูลทําไดโดย เลือกเมนูแกไขขอมูล เลือก
รายชื่อในระบบที่ตองการแกไข จากนั้นเปลี่ยนระดับเพื่อเพิ่มหรือลดสิทธิการใชขอมูล แลวทํา
การเปลี่ยนแปลงขอมูลที่ตองการแกไข เชน ชื่อ รหัสผาน ชื่อ-นามสกุล จริง ตําแหนง รหัส
ประจําตัว เมื่อเสร็จทําการบันทึกโดยการกดปุม Submit ในการลบนั้นก็สามารถทําไดโดย เลือก
เมนูบันทึก และเลือกรายชื่อจากเมนูแลวทําการกดปุม Submit เพื่อลบรายชื่อนั้นๆ
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การใชงานหนาตางวิเคราะหแผนที่ เปนสวนที่เปดโอกาสใหผูใชงานระบบซึ่งมีสิทธิในสวนนี้ทํา
การปรับแตงแผนที่ เพื่อสรางโอกาสทางความคิดในแงมุมตางๆดวยตนเอง อันเปนหนทางในการ
ไดมุมมองความคิดใหมๆในการ จัดการทรัพยากร ใหมีประสิทธิภาพ ซึ่งมีรูปแบบดังนี้

รูปท่ี 16 รูปสวนวิเคราะหแผนท่ี
หนาตางแบบออกเปน 3 สวนหลักคือ สวนชั้นการแสดงผล สวนแผนที่ภูมิศาสตร สวนเมนู
สวนชั้นแสดงผล เปนสวนสํารับเปดปดชั้นที่ตองการหรือไมตองการดูขอมูลแผนที่ตางๆ

เพื่อเปนไปตามความตองการของผูใชแผนที่
สวนแสดงแผนที่ภูมิศาสตร ขอมูลจะเปลี่ยนแปลงไป ที่ผูใชงาน เลือก ยอ ขยาย หรือการ

คนหาขอมูลตางๆบนแผนที่ ซึ่งจะมีลักษณะเปน พลวัตร (Dynamics Map)
สวนเมนูตางๆ ประกอบดวย 3 สวนยอย คือ เคร่ืองมือทั่วไป อันไดแกการยอ การขยาย การ

เลื่อนแผนที่ภูมิศาสตร เปนตน สวนที่ 2 คือ สวนเคร่ืองมือพิเศษ ใชในการเลือกวัตถุบนแผนที่
ภูมิศาสตร การสรางบัพเฟอรจากวัตถุตางๆ และ การเลือกขยายตามวัตถุที่ถูกเลือก
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รูปที่ 17 การเลือกวัตถุในขอบเขตที่กําหนด (Select Within)
เลือกวัตถุที่ตองการจะเลือกวัตถุซึ่งอยูภายใตขอบเขต จากนั้นกดปุม Select Within เลือกประเภท
วัตถุที่ตองการจะเลือก

รูปท่ี 18 การขยายมาตราสวนโดยการระบุมาตราสวน
เลือกที่ เมนู Zoom Scale จากนั้นระบุตัวเลขที่ชอง New Scale ซึ่งมีหนวยเปนเมตรจากนั้นกดที่ปุม
OK ก็จะไดผลลัพธของแผนที่ภูมิศาสตรที่ตองการ
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รูปที่ 19 การขยายแผนที่ภูมิศาสตรตามวัตถุที่เลือก
การขยายแผนที่ภูมิศาสตรตามวัตถุที่เลือก กระทําไดโดยเลือกวัตถุที่ตองการขยาย แลวก็
เลือกปุม Zoom Selected เพื่อขยายวัตถุนั้นๆเต็มจอของบริเวณการแสดงแผนที่ภูมิศาสตร

ในการพิมพแผนที่ภูมิศาสตรกระทําไดโดย เลือกกดที่เมนู Print จากนั้นจะปรากฏหนาตางเพื่อให
เลือกรายละเอียดตางๆ ตามตองการวา ซึ่งประกอบดวยสวนตางๆดังนี้

Title คือ สวนชื่อแผนที่ภูมิศาสตรที่ตองการพิมพ
Legend คือ สวนรายละเอียดบนแผนที่
Scale bar คือ มาตราสวนที่จะระบุบนแผนที่
North Arrow คือ สัญลักษณเพื่อบอกทิศเหนือของแผนที่
URL คือ ชื่อเวบไซตหรือที่อยูของแผนที่วาอยูที่ใด
Date/Time คือ วัน/เวลาปจจุบันขณะที่ทําการพิมพ
Map Site คือสวนที่ใหระบุมาตราสวนเองหรือใหเลือก แบบอัตโนมัติซึ่งจะพิมพเต็มแผน
กระดาษ และทายสุดเปนสวนเซ็ตคาของเครื่องพิมพ ซึ่งแตกตางกันออกไป
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รูปที่ 20 การพิมพแผนที่

รูปที่ 21 การทําบัพเฟอร
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การทําบัพเฟอร นั้นกระทําไดโดยเลือกวัตถุที่ตองการจะทําบัพเฟอร จากนั้นเลือกเมนู Buffer
จะปรากฏหนาตางดังรูปที่ 30 จากนั้นระบุคุณสมบัติของบัพเฟอรที่ตองการ ดังนี้

Buffer Offset Distance คือระยะหางจากวัตถุที่เลือกจะกําหนดใหมีคาเทาใดพรอมหนวยวัด
Create buffer on คือใหระบุชื่อชั้นที่ตองการสรางบัพเฟอร (Buffer Layer)
Construct One Buffer for all Selected map feature เปนการเลือกเมื่อตองการเชื่อมบัฟเฟอร
กรณีเลือกเลือกวัตถุที่ มีขอบเขตของบัพเฟอรติดกันและเปนบัฟเฟอรเดียวกัน
Fill & Edge เปนการระบุคุณสมบัติของบัพเฟอรที่ตองการวาตองการ ใหมีคุณสมบัติอยาง
ไรบาง เชน เสน สี ระบายทึบ หรือมีรูปแบบที่เปน ลวดลายตางๆ ตามที่ระบุ

รูปที่ 22 การวัดระยะทาง
การวัดระยะทางกระทําไดโดยเลือกเมนู Measure จากนั้นก็ระบุตําแหนงบนแผนที่ กรณี
การระบุตําแหนงมากกวา 1 จุดขอมูลความยาวของระยะทางก็จะรวมใหโดยสังเกตุไดจาก
กลองแสดงระยะทางปรากฏในรูป ซึ่งระยะทางที่ปรากฏหมายถึงระยะทางของตําแหนง
ปจจุบันยอนหลังไป 1 ตําแหนงแตระยะทางรวมจะนับรวมตั้งแตจุดเร่ิมตน
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รูปท่ี 23 การเพิ่มเติมขอมูลบนแผนที่
การเพิ่มเติมขอมูลบนแผนที่เปนการเพิ่มเติมขอมูลในลักษณะเฉพาะบุคคลซึ่งเปนคนละสวนกับขอ
มูลหลัก เพื่อบันทึกขอมูลอันเปนประโยชน หรือชวยในการจัดการของแตละเฉพาะบุคคล เชนการ
เพิ่ม เสน รูปปด วงกลม ตัวอักษรตางๆ รวมทั้งสัญลักษณ ทั้งนี้สามารถกําหนดรูปแบบตางๆไดตาม
ตองการ
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ภาคผนวก ช
(ตัวอยางแบบสอบถาม)

แบบสอบถาม
ระบบสารสนเทศภูมิศาสตรเพ่ือการแจงความและสถิติอาชญากรรม

ของตํารวจภูธรเชียงใหม

คําชี้แจง
1. แบบสอบถามมีวัตถุประสงคเพื่อตองการทราบผลการใชงานเพื่อการแจงความและสถิติ

อาชญากรรม ของตํารวจภูธรเชียงใหม และเพื่อเปนขอมูลในการปรับปรุงและพัฒนาใหมีประ
สิทธิภาพตอไป

2. ความคิดเห็นที่ทานตอบนี้มีคุณประโยชนเปนอยางยิ่ง และคําตอบของทานจะไมสงผลกรทบ
ตอผูตอบแบบสอบถามใดๆ ทั้งสิ้น

แบบสอบถามมีทั้งหมด 3 ตอน คือ
ตอนที่ 1 ขอมูลของผูตอบแบบสอบถาม
ตอนที่ 2 ประสิทธิภาพของการใชงานระบบ
ตอนที่ 3 ขอเสนอแนะและแนวทางในการปรับปรุงและพัฒนาระบบ

      ตอนที่ 1 ขอมูลผูตอบแบบสอบถาม ลงใน
         โปรดทําเครื่องหมาย    �  ลงใน   �  หนาขอความที่ตรงกับความเปนจริง

         �  เจาหนาที่ตํารวจผูรายงานคดี ประจําสถานีตํารวจ
         �  เจาหนาที่ตํารวจหัวหนาสถานีตํารวจ
         �  เจาหนาที่ตํารวจระดับบริหารประจําภูธรจังหวัดเชียงใหม
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ตอนที่ 2 ประสิทธิภาพของการใชงานระบบสารสนเทศภูมิศาสตรเพื่อการแจงความและสถิติ
               อาชญากรรมของตํารวจภูธรเชียงใหม

   โปรดทําเครื่องหมาย    �  ลงใน ชองที่ทานเห็นวาเปนจริงมากที่สุด

ลักษณะการใชงานระบบสารสนเทศภูมิศาสตรเพ่ือการ
แจงความและสถิติอาชญากรรม

ของตํารวจภูธรชียงใหมในดานตางๆ มา
กท

ี่สุด

มา
ก

ปา
นก

ลา
ง

นอ
ย

นอ
ยท

ี่สุด

1. ความสะดวกตอการใชงาน
2. หนาตางการใชงานระบบเขาใจงายไมซับซอน
3. ความเหมาะสมของการจัดวางเมนู การใชงานบนจอภาพ
4. ความถูกตองของขอมูลหลังจากการสืบคน
5. ความสมบูรณของรายงาน
6. มีระบบการรักษาความปลอดภัยที่ดี
7. การสืบคนขอมูลทําไดงายและสะดวก
8. คูมือการใชงานระบบ มีความชัดเจนตอการใชงาน
9. ชวยลดขั้นตอนการทํางานปจจุบัน
10. สามารถนําระบบไปประยุกตใชงานไดจริง

ตอนที่ 2 ขอเสนอแนะและแนวทางการปรับปรุงและพัฒนาระบบสารสนเทศภูมิศาสตรเพื่อการ
               แจงความและสถิติอาชญากรรมของตํารวจภูธรเชียงใหม
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………
………………………………………………………………………………………………………..

ขอขอบพระคุณที่ใหความรวมมือในการตอบแบบสอบถาม
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ภาคผนวก ซ
รูปแบบ รายงานคดีอาญาท่ัวไป แบบเดิม
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รูปแบบ รายงานคดีจราจร แบบเดิม
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ประวัติผูเขียน

ชื่อ-สกุล นาย ประสงค ปาณศรี

วัน เดือน ปเกิด 18 ธันวาคม 2510

ประวัติการศึกษา สําเร็จการศึกษาปริญญาตรีครุศาสตรบัณฑิต
สาขาวิชาการศึกษา สถาบันราชภัฎเชียงใหม
ปการศึกษา 2538

ประสบการณ อาจารยพิเศษ คณะสถาปตยกรรม มหาวิทยาลัยเชียงใหม
สอนคอมพิวเตอรเพื่อการออกแบบ (Computer Aided Design)

ตําแหนง Network Operation Center Manager
บริษัท เชียงใหม อินเทอรเน็ต จํากัด
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